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Anotace 
Analýza obrazu je velmi obsáhlé téma, proto se tato bakalářská 

práce zabývá pouze vyuţitím počítačového vidění a analýzy obrazu při 

běţných úlohách řešených ve vědecké sféře. V rámci bakalářské práce je 

zjišťována pouţitelnost běţně dostupných hardwarových i softwarových 

nástrojů pro vytvoření metodiky hromadného měření obsahu plochy listů 

křídlatky. Součástí metodiky je popis jejích kroků, včetně řešení 

moţných úskalí, které mohou v průběhu aplikace metodiky nastat. Dále 

práce obsahuje popis přiloţeného makra vytvořeného pro analytický 

program ImageJ a seznámení se samotným programem. Nakonec jsou 

prezentovány výsledky získané aplikací metodiky. 

Klíčová slova: Analýza obrazu, zpracování obrazu, detekce 

objektů v obraze, měření plochy listů, křídlatka, ImageJ 



 

Abstract 
Because image analysis is a very broad topic, this thesis deals 

only with the use of computer vision and image analysis for common 

tasks solved in the scientific industry. The thesis investigated the 

applicability of common hardware and software tools for creating a 

methodology for measuring the mass area of knotweed leaves. Part of the 

methodology is a description of its steps, including addressing possible 

pitfalls that can occur during application of the methodology. 

Furthermore thesis contains a description of the included macro created 

for ImageJ analysis program and introduction to the program itself. 

Finally, there are presented results obtained by application of the 

methodology. 

Keywords: Image analysis, image processing, object detection, 

measurement of leaf area, knotweed, ImageJ 

 



 

Poděkování 
Rád bych poděkoval Ústavu systémové biologie a ekologie 

Akademie věd České republiky v Českých Budějovicích, konkrétně 

RNDr. Boţeně Šeré, Ph. D. a Mgr. Ivetě Gajdové, za spolupráci při 

vytváření metodiky, za poskytnuté materiály a v neposlední řadě za 

spoustu uţitečných rad a postřehů. 

Dále bych rád poděkoval svému vedoucímu práce, Ing. Michalovi 

Šerému za odborné vedení mé bakalářské práce, vhodné připomínky a 

cenné rady. 

 



 

Obsah 

1 ÚVOD .................................................................................................................... 10 

2 POČÍTAČOVÁ ANALÝZA OBRAZU .............................................................. 12 

3 CÍLE PRÁCE ....................................................................................................... 13 

4 POPIS SOUČASNÉHO POSTUPU MĚŘENÍ .................................................. 14 

5 ROZBOR NAVRHOVANÉHO ŘEŠENÍ .......................................................... 15 

 VSTUPNÍ PŘEDPOKLADY NOVÉHO ŘEŠENÍ ........................................... 17 5.1

5.1.1 Zachování přesnosti.................................................................. 17 

5.1.2 Automatizace procesu ............................................................... 17 

6 PROBLEMATIKA ZPRACOVÁVÁNÍ POMOCÍ IMAGEJ .......................... 18 

7 POROVNÁNÍ IMAGEJ S OSTATNÍMI PROGRAMY NA TRHU ............... 20 

8 METODIKA VYUŽITÍ DIGITÁLNÍ ANALÝZY OBRAZU PŘI 

HROMADNÉM MĚŘENÍ OBSAHU PLOCHY LISTŮ .......................................... 22 

 VYBAVENÍ NUTNÉ PRO POUŢITÍ METODIKY ......................................... 22 8.1

 POPIS METODIKY................................................................................. 23 8.2

8.2.1 Příprava prostředí a zdrojového materiálu .............................. 23 

8.2.2 Záznam obrazu ......................................................................... 25 

8.2.3 Úprava obrazu .......................................................................... 27 

8.2.4 Nastavení prahování (Threshold) a binarizace obrazu ............ 30 

8.2.5 Rozpoznávání a počítání objektů a jejich ploch ....................... 31 

8.2.6 Kalibrace měřítka ..................................................................... 32 

8.2.7 Práce s makrem ........................................................................ 34 



 

9 ANALÝZA VÝSLEDKŮ ..................................................................................... 37 

 POROVNÁNÍ VÝSLEDKŮ Z PŮVODNÍ A NOVÉ METODIKY ...................... 37 9.1

 DÍLČÍ EXPERIMENTY ........................................................................... 37 9.2

 SOUHRNNÉ VÝSLEDKY ........................................................................ 40 9.3

10 ZÁVĚR.................................................................................................................. 42 

SEZNAM OBRÁZKŮ .................................................................................................. 43 

SEZNAM TABULEK................................................................................................... 45 

REFERENCE ............................................................................................................... 46 

PŘÍLOHA – DVD ......................................................................................................... 48 

 



Úvod    

10 

1 Úvod 
V dnešní době se běţně potýkáme s úlohami, které jsou efektivně 

řešeny s pomocí počítačového vidění. Jde o velmi rozsáhlou disciplínu, která 

za posledních 50 let prošla bleskurychlým vývojem [1]. 

Základní myšlenka disciplíny počítačové analýzy leţí v napodobení 

lidského vidění a vnímání. Efektivita schopností lidského mozku a nervové 

soustavy je však nad síly výpočetního výkonu i těch nejrychlejších počítačů 

dneška. Nicméně, existují takové oblasti, kde analýza obrazu přináší pouţitelné 

výsledky [2, s. 177-178]. 

Lze mluvit o dvou cestách, po kterých se momentálně výzkum na tomto 

poli ubírá. Na jednu stranu výsledky výzkumu oblastí digitálního zpracování a 

analýzy obrazů přinesly řadu vylepšení technologií v dnešní spotřební 

elektronice, jako například automatické rozpoznávání textu, fotografií, či videa, 

sledování objektů pomocí zabezpečovacích systémů, kontrola jakosti produktů, 

sledování provozu na pozemních komunikacích, a mnoho dalších. Produkty 

pouţívané v této spotřebitelské sféře jsou levné a výstupy z nich většinou 

postačí laickým potřebám. Na druhé straně však stojí vědečtí pracovníci, kteří 

ke své práci potřebují přesnější přístroje. Proto pro potřeby vědecké sféry 

vznikají specializované (a samozřejmě draţší) přístroje a programové 

balíky [3]. 

Je ale moţné vzít v potaz ještě třetí moţnost, kterou se zabývá právě 

tato bakalářská práce. Jde o kombinaci spotřební techniky a vědeckých nástrojů 

a jejich úpravy tak, aby výsledek vyhovoval našim potřebám. 

Díky spolupráci s Akademií věd České republiky, se podařilo sesbírat 

několik příkladů přímo z probíhajících experimentů, které by bylo moţné 

zefektivnit vyuţitím počítačového vidění. Při literární rešerši bylo zjištěno, ţe 

většina příkladů byla uţ řešena v jiných, volně na internetu dostupných 

dokumentech, proto se s nimi v této práci nesetkáte.  
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Experiment v probíhající v Ústavu systémové biologe a ekologie 

Akademie věd, na který se tato práce plně zaměřuje, se týká zástupců rodiny 

rostliny Reynoutria (křídlatka). Tato rostlina je v České republice cizopasnou 

rostlinou, proto mezi zemědělci roste zájem o informace, které pomohou jejímu 

vyhubení, nebo alespoň rapidnímu sníţení výskytu. Cílem pokusu je tedy tyto 

informace získat a probíhá následujícím způsobem. V kontrolovaném prostředí 

v areálu patřící Akademii věd je zasazeno několik vzorků rostliny z různých 

měst České republiky. Rostliny jsou poté čtyřikrát v roce sklizeny. 

Z nasbíraných vzorků se sbírají data o počtu jednotlivých větví kaţdé rostliny, 

hmotnosti biomasy, počtu listů na kaţdé větvi a plochy kaţdého jednotlivého 

listu. Metodika počítání větví a váţení biomasy je pravděpodobně uţ 

dostačující, ale momentální způsob sběru dat o plochách listů a jejich počtu je 

velmi neefektivní.  

Metody běţně vyuţívané k podobným řešením se dělí na metody 

přímým a nepřímým měřením. Druhé jmenované lze vyloučit, a to proto, ţe 

k těmto metodám je nutné vlastnit buďto speciální zařízení, nebo jde o 

odhadové metody. K metodám přímým měřením patří výpočet vyuţívající 

podobnosti listů s jednoduchými geometrickými tvary, měření planimetrem, 

váţením kopií listů nebo přímé váţení listů. Ţádná z těchto metod ale není 

dostatečně přesná, ani nepřináší kýţené časové zlepšení [10, s. 6394-6395]. 

Proto jedním ze způsobů zefektivnění nynějšího způsobu sbírání dat je 

vytvoření nové metodiky takové, která vyuţívá analýzy obrazu. 
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2 Počítačová analýza obrazu 
Základním cílem počítačové analýzy obrazu je intepretace informací 

pocházejících z rekonstrukce 2D obrazů nebo jejich sekvencí (například 

videozáznam). Toho se snaţí dosáhnout extrakcí rysů objektů (jako například 

jejich obrysů) nebo segmentací obrazu do několika oblastí. Poté můţou být 

jednotlivé reprezentace analyzovány. Například v robotice, pro kterou je 

počítačové vidění esenciální disciplínou, se pak vyuţívá porovnávání objektů 

na základě analýzy jejich rysů [4, s. 2-3]. 

Existuje řada problémů, se kterými se počítačová analýza potýká. Mezi 

ty nejobecnější patří obtíţe spojené s pořizováním digitálního obrazu 

a problémy při interpretaci výsledků. Optická čočka je pro pořizování 

reprezentace reality nedokonalá a v obrazu pak vznikají odlišnosti od 

skutečnosti jako šumy, rozostření, geometrické deformace a další. To, společně 

se ztrátou informace při pořizování dvojrozměrných snímků obsahujících 

trojrozměrných objekty v prostoru, značně ztěţuje celkovou analýzu. Proto je 

třeba při vytváření algoritmů pro analýzu obrazu počítat se specifičtějšími 

problémy (například při detekci rysů objektů, analýze textur, řešení orientace 

3D objektů v prostoru, reprezentaci objektů, a tak dále) [4, s. 3-6]. 

Metodika popsaná v praktické části této bakalářské práce byla 

vytvořena s vědomím těchto úskalí, proto obsahuje pravidla nejen pro samotné 

zpracování v počítači, ale i pro pořizování snímků tak, aby mohly být rysy 

objektů na nich zachycené co nejlépe analyzovány.  
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3 Cíle práce 
Hlavním cílem této bakalářské práce je prozkoumání původní metodiky 

pouţívané při sběru dat o počtech a plochách listů křídlatky. Dále návrh a 

vytvoření metodiky nové, určené pro hromadné měření a vyhodnocování 

plochy listů, jejíţ dílčí kroky tvoří: 

 Popis metodiky samotné, včetně přípravy listů, prostředí 

a zařízení, pravidel správného získávání snímků a tipů pro 

post-processing nepovedených snímků. 

 Vytvoření vhodného prostředí, ve kterém se bude experiment 

provádět. 

 Vytvoření makra pro automatické dávkové zpracování. 

 Vyhodnocení výsledků naměřených programem a porovnání 

výsledků z nové a staré metodiky. 

To vše tvoří praktickou část, teoretická část sestává ze seznámení 

s ImageJ, programem pro vědecké zpracování a analýzu obrazu, vysvětlením 

jeho výhod pro vědeckou i laickou veřejnost a srovnání s dalšími dostupnými 

nástroji.  
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4 Popis současného postupu měření 
Současné řešení vychází z metody měření plochy váţením kopií listů. 

Jde o známou, velmi dlouho pouţívanou, přesto přesnou metodu na principu 

trojčlenky, která je však při velkém mnoţství vstupních vzorků časově náročná. 

K realizaci této metody potřebujeme dostatečně velký papír 

o homogenní hmotnosti, tuţku, nůţky a laboratorní váhy. Princip je tvořen 

čtyřmi kroky: 

 Ze všeho nejdříve se změří hmotnost (m1) jednoho kusu papíru, 

ze kterého budeme posléze vystřihovat. To poslouţí ke zjištění 

poměru mezi jeho plochou a hmotností. 

 Dále je třeba obkreslit tvar listu a následně tento tvar 

vystřihnout. 

 Vystřihlý obrys se poté zváţí na vahách a zapíše se jeho 

hmotnost (m2).  

 Nakonec se díky poměru z prvního kroku spočítá obsah plochy 

pomocí vzorce 
      

  
 (spočítaná plocha vyjde v jednotkách 

cm
2
). 

K výhodám této metodiky patří především přesnost, která ale závisí 

mimo jiné na relativní odchylce vah a lidském faktoru. K dalším patří 

dostupnost a relativní jednoduchost na zpracování. 

Jako zásadní nevýhoda se jeví velká časová náročnost a s ní související 

pracnost, coţ jsou společné vlastnosti dalších podobných „ručních“ metod [5]. 
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5 Rozbor navrhovaného řešení 
Před nasazením nové metodiky bylo třeba nejdříve přizpůsobit návrh 

řešení vstupním podmínkám. 

 Vybavení bude moţné pouţít pouze to, které je k dispozici. Pro 

samotné snímání obrazu se jeví vhodně jen A4 skener HP a 

digitální fotoaparát Canon EOS 1000D. Pozn.: Po několika 

pokusech (viz podkapitola 9.2) byl z těchto dvou moţností 

nakonec vybrán jako vhodnější fotoaparát. 

 Dále bude navrţena a přizpůsobena místnost vhodná pro focení. 

Uprostřed místnosti bude vytvořena bytelná konstrukce slouţící 

k připevnění fotoaparátu. Fotoaparát bude posléze namířen 

kolmo ke snímané ploše (Obrázek 1). Aby se zamezilo 

neţádoucímu světelnému ruchu, který by mohl budoucí snímky 

ohrozit, doprostřed místnosti se postaví jediný světelný zdroj 

nastavený tak, aby světlo, které se odrazí na snímanou plochu, 

bylo co nejvíce rozprostřené. 

Obrázek 1: Návrh rozloţení pracovní místnosti 
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 Pro pozdější zpracování snímků v počítači je navrţen program 

ImageJ, který lze bez problémů provozovat na stávajících PC 

v laboratoři a je dostatečně univerzální (bliţší informace 

naleznete v podkapitole 5.2). Jako další výhody tohoto 

programu, které se mohly při aplikaci metodiky vyuţít, se jeví 

jeho rozšiřitelnost pomocí maker nebo pluginů a moţnost přímo 

v programu vyuţívat digitálních úprav obrazu. 

 Míra přesnosti nové metodiky by měla být přibliţně stejná jako 

u té původní. Pro zjištění přesnosti se navrhlo pouţití  původní 

metodiky jako referenční k nové metodice. Původní výstup 

(vystřiţené kopie listů) bude pouţit jako vzor pro novou 

metodiku a porovnají se výsledky obou metodik (viz kapitola 9).  

 Pro co největší zautomatizování procesu je třeba navrhnout 

nejlépe makro, popřípadě plugin, pracující s aplikací ImageJ. 

S jeho pomocí bude moţné analyzovat data z fotografií pomocí 

pouhých pár kroků. Určité zpomalení procesu nastává při 

samotném focení, proto by mohlo být řešením pouţití dálkového 

ovládání fotoaparátu, případně i jeho přímé zapojení do počítače 

(tím by se eliminovala nutnost přenášení paměťové karty 

z fotoaparátu do počítače).  
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 Vstupní předpoklady nového řešení 5.1

Nová metodika si klade za cíl znatelně urychlit sběr a kategorizaci dat 

při zachování přibliţné přesnosti původní metodiky. Toho se snaţí docílit 

pomocí co nejpřesněji popsaných pravidel pro přípravu a snímání obrazu a 

maximálně zautomatizovaného procesu. 

5.1.1 Zachování přesnosti 

Předpoklad je, ţe se dodrţí limit 5 % jako hranice přesnosti oproti 

původní metodice. Pomocí několika dílčích experimentů bude zjišťován vliv 

světelných podmínek, prostředí a nastavení fotoaparátu na výsledky analýzy. 

Pokud vyjde průměrná odchylka větší neţ 5 %, bude třeba některou část 

metodiky upravit. 

5.1.2 Automatizace procesu 

Proces bude zautomatizován tak, aby uţivatel strávil co nejméně času 

při pořizování fotografií a analýze výsledků. Předpokládané časové zlepšení na 

základě pozorování je o 80 – 95 %. 
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6 Problematika zpracovávání pomocí ImageJ 
ImageJ je program v licenci public domain (volné dílo). Je tedy moţné 

s ním svobodně nakládat ke komerčním i nekomerčním účelům a modifikovat 

jeho zdrojový kód. Jeho autorem je Wayne Rasband, dobrovolník v americkém 

National Institute of Mental Health (Národní ústav zdraví USA
1
, dále jen 

NIMH). Program je napsaný v jazyce Java a dostupný pro všechny majoritní 

operační systémy (Windows od verze 2000, Mac OS X od verze 1.5, Linux) a 

řadu dalších. Vychází z NIS Image, původního programu NIMH pracujícím jen 

v Mac OS. 

Existuje několik distribucí a balíků vycházejících z ImageJ, jejichţ účel 

je buď vylepšení stávajících funkcí ImageJ, nebo jeho úprava pro řešení 

specifických úloh. Mezi nejznámější patří: 

 Fiji  (Fiji Is Just ImageJ) je objemově největší a nejznámější balík. 

Zaměřuje se mimo jiné na registraci a segmentaci obrazu, feature 

extraction metody, 3D vizualizaci a další. Přináší řadu výhod a 

vylepšení oproti původnímu ImageJ, jak pro normální uţivatele, tak 

pro vývojáře. 

 µManager je speciální balík vytvořený pro práci s automatizovanými 

mikroskopy.  

 SalsaJ je vytvořený pro pouţití v třídním prostředí. Dále má 

implementovanou podporu pro práci s profesionálními 

astronomickými snímky. 

 Bio7 je grafické prostředí pro vytváření modelů ekologických 

prostředí.  

ImageJ nemá unifikované GUI, coţ znamená, ţe kaţdý otevřený 

obrázek, nebo proces má vlastní okno. V hlavním okně programu nalezneme 

                                                 
1
 Český překlad dle prof. PhDr. Rudolfa Kohoutka, CSc. 
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lištu nástrojů (Obrázek 2). Síla programu ale stojí ve funkcích, které najdeme 

v menu: 

 File obsahuje klasické příkazy pro otevírání, zavírání a tisk souborů. 

Mezi podporované formáty patří TIFF, GIF, JPEG, PNG, DICOM, 

BMP, PGM a FITS
2
. 

 Edit obsahuje nástroje pro práci se schránkou, s výběry (výběry jsou 

nedestruktivní, to znamená, ţe se tvoří v nezávislé vrstvě nad 

obrázkem. Lze je vytvářet buď pomocí standartních nástrojů výběru, 

nebo příkazem Selection › Specify) a nastavení programu. 

 Image obsahuje nástroje pro úpravu obrazu (více v podkapitole 8.2.3). 

 Process obsahuje další nástroje pro úpravu obrazu a filtry. Většinou je 

pouţíváme pro úpravy umoţňující pozdější analýzu. 

 Analyze  obsahuje nástroje pro analýzu a měření obrazu.  

 V Plugins najdeme nainstalované pluginy a makra. Dále je zde nástroj 

pro instalaci, editaci a debugging maker a kompilátor pluginů. 

 Window obsahuje příkazy pro setřídění otevřených oken.  

 Help obsahuje odkazy na online nápovědu, domovskou stránku 

projektu a další uţitečné odkazy spolu s informacemi o verzi ImageJ a 

pluginech. 

                                                 
2
 Podporu formátů lze rozšiřovat o další pomocí pluginů třetích stran. 

Obrázek 2: Náhled hlavního okna ImageJ s lištou nástrojů 
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7 Porovnání ImageJ s ostatními programy na 
trhu 

ImageJ samozřejmě není jediný program určený k úpravám a analýze 

obrazu. Existují komerční aplikace, většinou spojené s konkrétním hardwarem, 

jako například Clemex Captiva určený pro analýzu snímků z mikroskopu. 

K dalším nevýhodám komerčních aplikací patří fakt, ţe jde většinou 

o proprietární software, často s nemoţností rozšíření, coţ znamená, ţe uţivatel 

vlastně neví, co která funkce programu ve skutečnosti dělá. I kdyţ jde často 

o dostatečně univerzální řešení (například Image-Pro Plus nebo MetaMorph®), 

tak kvůli uzavřenosti a vysokým pořizovacím nákladům nelze v tomto případě 

povaţovat jakékoli z komerčních řešení za vhodné [9]. 

V případě, ţe se zaměříme na freeware a open-source nástroje, lze 

nalézt jen málo kvalitních univerzálních programů pro analýzu obrazu. 

Tabulka 1 reprezentuje několik
3
 z těch potenciálně nejpodobnějších ImageJ, 

společně s jejich vlastnostmi. 

Legenda k tabulce 1: 

⌂ : Domovská stránka aplikace 

∼ : Vlastnosti a schopnosti programu shodné s ImageJ. 

+ : Zásadní positiva oproti ImageJ. 

 : Zásadní negativa oproti ImageJ. 

  

                                                 
3
 Ze seznamu byla vyjmuta aplikace Cell Profiler (http://www.cellprofiler.org/) pro 

její specializaci spíše na mikrobiologii 
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Image Tool 

⌂ http://ddsdx.uthscsa.edu/dig/itdesc.html 

∼ Otevřená architektura a moţnost rozšíření pomocí pluginů 

Dobrá podpora obrazových formátů 

Podpora standartních funkcí pro úpravu obrazu 

+ Podpora pluginů vytvořených pro Adobe Photoshop 

 Skriptovací jazyk nedosahuje moţností maker v ImageJ 

Není podpora jiných operačních systémů, neţ Windows 

Ukončený vývoj aplikace (poslední verze vyšla pro OS Windows 98) 

Acquiarium 

⌂ http://cbia.fi.muni.cz/projects/ 

∼ Otevřená architektura a moţnost rozšíření pomocí pluginů 

Dobrá podpora obrazových formátů 

Podpora standartních funkcí pro úpravu obrazu 

+ Robustnější software 

CZ podpora 

 Nepodporuje makra 

Pro účely této bakalářské práce příliš těţkopádný 

Scion Image 

⌂ Není 

∼ Otevřená architektura a moţnost rozšíření pomocí pluginů 

Stejně jako ImageJ vychází z NIH Image 

Podpora standartních funkcí pro úpravu obrazu 

+  

 Pouze pro operační systémy Windows 

Uţ se nevyvíjí 

Tabulka 1: Přehled programů pro analýzu obrazu nejpodobnějších ImageJ a stručný výčet 

jejich vlastností 
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8 Metodika využití digitální analýzy obrazu při 
hromadném měření obsahu plochy listů 

 Vybavení nutné pro použití metodiky 8.1

 SNÍMACÍ ZAŘÍZENÍ 

Digitální nebo analogový fotoaparát, či skener. Při pouţití analogového 

fotoaparátu je nutné pouţít skener na negativy. Nejvhodnějším zařízením je 

digitální zrcadlovka nebo velkoformátový skener
4
. 

Použité vybavení: fotoaparát Canon EOS 1000D s referenčním objektivem  

18-55mm.  

 PODKLAD 

Nejlépe černý podklad z materiálu, který nevrhá odlesky a pohlcuje 

stíny. 

Použité vybavení: pruh látky z černého dyftýnu. 

 VHODNÝ OBJEKT PRO KALIBRACI 

Pro správnou kalibraci rozměrů obrazu se v této metodice pouţívá 

referenční čtvercový objekt nejlépe z bílého nelesklého materiálu (papíru). 

Použité vybavení: papírový čtverec o přesných rozměrech 10×10 cm (viz 

Obrázek 7).  

  

                                                 
4
 Tato metodika počítá s pouţitím digitálního fotoaparátu, při pouţití skeneru by bylo 

pravděpodobně nutné některé její části upravit. 
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 HARDWARE 

Počítač (stolní, či notebook) s minimálně 512MB paměti RAM schopný 

provozovat aplikaci ImageJ. Pro přenos fotografií z fotoaparátu je nutná 

minimálně čtečka karet. 

Použité vybavení: notebook Dell Inspiron 6400, 4GB paměti RAM, procesor 

Core2Duo, integrovaná grafická karta Intel GMA945 se sdílenou pamětí. 

 SOFTWARE 

Program ImageJ 1.38 a novější, operační systém schopný provozovat 

ImageJ (jsou podporovány majoritní systémy MS Windows, Linux a Mac OS), 

tabulkový procesor MS Excel nebo OO Calc (v krajním případě stačí jakýkoli 

plaintext editor). 

Použité vybavení: MS Windows 7 Professional 64-bit, ImageJ 1.44,  

MS Excel 2010. 

 Popis metodiky 8.2

Ke správné aplikaci metodiky je třeba dodrţovat pořadí níţe popsaných 

kroků. Zanedbání některého z dřívějších kroků můţe negativně ovlivnit 

všechny následující a tím pádem i výsledné hodnoty. Zvláštní důraz je třeba 

věnovat zejména plánování prostředí, ve kterém bude experiment probíhat, 

(více v podkapitole 8.2.1) a správnému nastavení fotoaparátu (podkapitola 

8.2.2). 

8.2.1 Příprava prostředí a zdrojového materiálu 

K co největší eliminaci rušivých vlivů a minimalizaci deformací později 

pořizovaných fotografií je třeba promyšleně vybavit místnost, kde se bude 

metodika provádět. Pro co nejlepší odstranění neţádoucích stínů a odlesků je 
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třeba, aby byla místnost důkladně zatemněná od vnějších světelných zdrojů – 

nejlépe tedy místnost bez oken.  

Aby byly snímky co nejkontrastnější, je třeba zvolit vhodný podklad. 

V případě, ţe je moţné zaručit prostředí s měkkým světlem, které nevrhá stíny 

a dopadá přímo kolmo a rovnoměrně na plochu, kterou budeme fotit, lze zvolit 

světlou podloţku v barvách bílé, či v barvách blíţících se základním barvám 

RGB spektra (červená, zelená, modrá). V opačném případě je vhodnější pouţít 

černý podklad, pokud moţno z materiálu, který pohlcuje stíny. 

Dále je vhodné přizpůsobit focení i samotné vzorky listů. Je 

pravděpodobné, ţe se listy po otrhání budou různými způsoby kroutit a měnit 

tvar, proto doporučujeme je před samotným snímáním nechat vylisovat, např. 

pod těţkou knihou. Na druhou stranu nedoporučujeme pouţívat na překrytí 

sklo, nebo jiné lesklé materiály, jelikoţ vytvářejí neţádoucí odlesky při focení. 

Stůl bylo třeba pokrýt jednolitou barevnou plochou, aby se co nejvíce 

zvýšil kontrast mezi pozadím a listy na něm položenými. Jako první 

z pokusných pozadí byly zvoleny papírové plochy v barvách bílé, modré 

a červené (modrá a červená barva byly navrženy z důvodu jednoduchého 

odfiltrování v jednom z kroků pozdější úpravy obrazu). Po několika prvních 

pokusech však bylo zjištěno, že ve stávajících podmínkách nelze eliminovat 

stíny vrhané listy na focenou plochu (Obrázek 15). Stín vrhaný listem byl totiž 

programem ImageJ analyzován spolu se samotným listem jako jeden objekt. 

Tohoto nežádoucího efektu by bylo možné se zbavit pomocí několika úprav, ale 

znamenalo by to individuální přístup ke každému snímku, čímž by se velmi 

znesnadnilo dávkové zpracování. Proto se nakonec použil materiál černého 

dyftýnu, který byl vůči listům dostatečně kontrastní a stíny pohlcoval. 
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8.2.2 Záznam obrazu 

Záznamem obrazu je myšleno samotné focení, či skenování plochy 

s listy. Tento krok je velmi zásadní, protoţe jakákoli chyba, která se zde objeví, 

můţe mít za následek velmi výrazné zdrţení při případných pozdějších 

úpravách. V krajním případě můţe nastat situace, kdy obrazová informace 

bude tak nekvalitní nebo nekompletní, ţe nebude moţné data z důvodu 

vysychání vzorků znovu získat. Proto doporučujeme po kaţdé sadě vzorků 

výstup z fotoaparátu ihned zkontrolovat. 

Existuje několik faktorů, které ovlivňují kvalitu získávaného obrazu a 

můţou mít vliv na měřené hodnoty. Mezi ně patří: 

 ZKRESLENÍ OBJEKTIVU 

 V závislosti na pouţitém zařízení a objektivu se jedná o větší, či menší 

deformaci obrazu oproti skutečnosti. U fotoaparátů, které nejsou nastavené 

přesně kolmo ohniskem objektivu vůči snímané ploše, se navíc zkreslení 

projevuje nerovnoměrně. Nejčastějším jevem je tzv. soudkovitost nebo naopak 

poduškovitost [6, s. 27-29]. Velmi zjednodušeně se dá říct, ţe čím více bude 

objekt vzdálen od osy středu objektivu, tím je deformace objektu větší. Tento 

jev lze vypozorovat například na Obrázku 13. 

 NEČISTOTY 

Kdyţ pomineme nečistoty na objektivu, je moţné, ţe spolu se vzorky se 

nasnímá i nějaký neţádoucí objekt, například prachová částice, nebo odpad z 

listů. 
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 NASTAVENÍ FOTOAPARÁTU 

Správné nastavení fotoaparátu je jedním z nejdůleţitějších faktorů 

vydařeného záznamu obrazu. Je třeba dbát hlavně dvou věcí: 

 Snímek musí být dostatečně kontrastní a nesmí být 

přeexponovaný nebo podexponovaný. 

 Snímek musí být zaostřen. 

Pro dávkové zpracování je navíc téměř nutné, aby série snímků měla 

shodné vlastnosti. 

Fotoaparát Canon EOS 1000D použitý v této metodice je možné, stejně 

jako několik dalších fotoaparátů stejného výrobce s funkcí LiveView, připojit 

k počítači dodávaným USB kabelem a pomocí aplikace Canon EOS Utility
5
 

pořizovat snímky přímo z počítače včetně náhledu v  reálném čase. Kromě 

funkcionality dálkového ovládání spouště lze ještě měnit nastavení režimu, 

clony, závěrky a ISO. Tím odpadá zdržování způsobené přenosem fotografií 

mezi fotoaparátem a počítačem. 

Pro co nejostřejší fotografie je vhodné využít manuálního ostření. To 

ale není možné u každého fotoaparátu. 

S přihlédnutím na scénu, která se fotila, nebylo třeba fotografovat 

v RAW formátu – ten by se mohl hodit v případě, že by bylo nutné později 

v počítači u snímků měnit barevnost, či expozici. Jako výstupní byla tedy 

nastavena nejkvalitnější možnost formátu JPG. Aby měly všechny fotografie co 

nejvíce společných charakteristik, byl zvolen manuální režim a následující 

nastavení: 

Rozlišení: 3888 × 2592 při 72 dpi, barevný prostor sRGB 

Clona: f/4.5 

                                                 
5
 http://cpn.canon-europe.com/content/product/canon_software/eos_utility.do 

http://cpn.canon-europe.com/content/product/canon_software/eos_utility.do
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Závěrka: 1/25 s 

ISO: 400 

Tyto nastavení lze brát jako referenční, ne jako doporučené. 

Samozřejmě záleží na světelných a jiných podmínkách. Například pro tmavší 

listy se jevilo nejvhodnější použití ISO 800, ostatní nastavení zůstala stejná. 

Tím se dosáhlo vhodného kontrastu společně s dostatečně světlými listy pro 

pozdější analýzu. 

8.2.3 Úprava obrazu 

Některé chyby vzniklé při zaznamenávání obrazu (viz podkapitola 

6.2.2) je moţné pomocí úprav úplně odstranit, nebo alespoň omezit tak, aby 

mohla být metodika provedena aţ do konce. K tomu lze v ImageJ vyuţít celou 

řadu nástrojů. Mezi nejpouţívanější patří: 

 OŘÍZNUTÍ (Image › Crop) 

V případě, ţe nasnímaný obraz obsahuje kus nevhodného pozadí, rušivé 

části, či objekty, které se nebudou analyzovat, je vhodné pouţít tuto funkci. 

V ImageJ je nejdříve třeba označit výběr pomocí nástrojů výběru. Po spuštění 

funkce se obraz ořízne do obdélníku podle krajních bodů výběru ve 

vodorovném i svislém směru (Obrázek 3). 

Obrázek 3: Ukázka funkce ořezu v ImageJ. Vlevo: Jednotlivé vybrané části snímku 

nemusí být obdélníkového tvaru. Vpravo: snímek se ořízne podle krajních bodů 

výběru. 
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 JAS A KONTRAST (Image › Adjust › Brightness/Contrast) 

Můţe nastat situace, kdy snímané objekty nejsou vůči pozadí kvůli své 

světlosti dostatečně kontrastní. Do určité míry lze zvýšit kontrast a světlost 

právě touto funkcí. Veškeré změny hodnot jsou v reálném čase viditelné na 

původním snímku a potvrzují se stisknutím tlačítka Apply (Obrázek 5).  

V případě, že fotíme listy, které mají některé části oproti jiným velmi 

tmavé (například zetlelé), lze pomocí ImageJ celé listy selektivně zesvětlit. 

Využitím experimentálního příkazu  Adjust › Color Threshold (více 

v podkapitole 8.2.4) je možné pomocí několika nastavení zahrnout do výběru 

pouze části obrazu, které nás zajímají (Obrázek 4).  

Po spuštění příkazu vybereme hodnotu pomocí nastavení Brightness 

takovou, při které máme zahrnuté celé listy a pomocí tlačítka Select je 

zahrneme do výběru. Jakmile budeme mít výběr hotový, příkazem Image › 

Adjust › Brightness/Contrast se zvýšením hodnoty Brightness  listy dostatečně 

zesvětlíme tak, aby mohly být rozpoznány v dalších krocích (Obrázek 5). Po 

stisknutí Apply můžeme pokračovat v další analýze. 

Obrázek 4:  Ukázka nastavení barevného prahování (Color Threshold) 
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 PŘEVOD OBRAZU DO 8 BITŮ (Image › Type › 8-bit A Image › 

Color › Split Channels) 

První příkaz převede obraz do odstínů šedé v 8 bitech. To je důleţité 

pro další analýzu obrazu. Druhý příkaz provede rozdělení zdrojového snímku 

do tří 8-bitových snímků obsahujících červené, zelené a modré komponenty 

originálu. V případě této metodiky se jeví vhodně vyuţití tohoto příkazu 

s vyuţitím zeleného kanálu pro další analýzu (po jeho provedení budou zelené 

listy nejsvětlejší), ale jak je vidět v Obrázku 6, často je vhodnější kanál 

červený. 

Obrázek 5: Ukázka selektivního zvýšení světlosti příkazem Brightness / Contrast 
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8.2.4 Nastavení prahování (Threshold) a binarizace obrazu 

Prahování neboli Thresholding je běţně vyuţívaná technika při detekci 

hran objektů, počítání objektů nebo měření částí obrazu. Vstupní obraz musí 

být převeden do 8 bitů (viz podkapitola 8.2.3). Nastavením prahování se docílí 

toho, ţe se původní pixely z obrazu v barvách šedi převedou na černobílý obraz 

podle hraniční hodnoty (v rozmezí od 0 do 255). Pixely s menší hodnotou šedé, 

neţ je hraniční hodnota, se převedou na černé a ty s větší zase na bílé. Tento 

proces se nazývá binarizace obrazu [7, s. 395-398]. 

V ImageJ existuje od verze 1.43l experimentální příkaz Adjust › Color 

Threshold, který ale není zcela spolehlivý a je často destruktivní. Navíc je 

problematická jeho implementace pro dávkové zpracování. Proto byl použit 

klasický příkaz Adjust › Threshold. Po spuštění příkazu máme na výběr 

Obrázek 6: Ukázka funkce Split Channels. a: originální snímek, b: červený kanál, 

c:zelený kanál, d:modrý kanál 
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z maximální a minimální hodnoty prahování. Dále je zde možnosti pro tmavé 

pozadí, které zvolíme, pokud je pozadí vůči objektům v popředí tmavší. V tuto 

chvíli však bylo pouze nastavené prahování, obraz ještě nebyl binarizovaný. 

Toho se docílilo příkazem Process › Binary › Make Binary. V případě, že 

bychom spustili příkaz Make Binary bez nastavené prahové hodnoty, došlo by 

k automatické binarizaci. V takovém případě by program zvolil 

nejpravděpodobnější prahovou hodnotu podle histogramu zdrojového snímku 

[7, s. 398-403]. 

8.2.5 Rozpoznávání a počítání objektů a jejich ploch 

Rozpoznávání a počítání objektů je jedna z nejčastějších úloh analýzy 

obrazu. Existuje několik způsobů rozpoznávání. V našem případě pouţíváme 

nejjednodušší, ale zároveň nejspolehlivější metodu. K její aplikaci je třeba mít 

na vstupu uţ binarizovaný obraz (viz podkapitola 8.2.4). Předpoklad je takový, 

ţe na vstupu je snímek se všemi objekty, které se vzájemně nepřekrývají a 

nezasahují do okrajů [7, s. 574-577]. 

Samotný princip spočívá v tom, ţe program zkoumá po řádkách 

z levého horního rohu do pravého dolního rohu kaţdý pixel. V případě, ţe 

nalezne černý pixel, označí cyklicky veškeré další sousedící pixely dohromady 

jako jeden objekt. Ten je započítán a pokračuje v dalším skenování s tím, ţe uţ 

dříve započítané pixely ignoruje. Algoritmus skončí po analýze posledního 

pixelu [8, s.126]. 

V ImageJ se analýza objektů provádí příkazem Analyze › Analyze 

Particles. Po jeho spuštění se objeví vyskakovací nabídka s několika 

možnostmi, z nichž nejdůležitější jsou: Size (zde nastavujeme spodní i vrchní 

limit obsahu objektů, které budou započítány do výběru), Display Results 

(zobrazení výsledků analýzy v tabulce), Include Holes (pokud je položka 
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aktivní, do obsahu plochy objektů se nebudou započítávat díry v nich) a 

Exclude Edges (v případě aktivní položky se nebudou vybírat objekty 

zasahující do okraje snímku). V závislosti na zvoleném nastavení se po stisknutí 

OK objeví původní snímek s označenými objekty a tabulkou obsahující jejich 

plochy. Tato tabulka se dá uložit do formátu kompatibilním s MS Excel nebo 

OO Calc, to je vhodné pro pozdější sběr a analýzu výsledků. 

8.2.6 Kalibrace měřítka 

Kalibrací měřítka se v tomto případě rozumí nastavení poměru mezi 

pixely v obraze a skutečnými rozměry. K tomu se v této metodice vyuţívá 

objekt tvaru čtverce o známých rozměrech, který je nasnímán spolu s ostatními 

vzorky. Je třeba, aby kaţdý snímek obsahoval tento objekt (správně nafocený 

kalibrační čtverec lze vidět na Obrázku 7). Pomocí analýzy objektů  

(viz podkapitola 8.2.5) je uţ znám počet pixelů, které čtverec obsahuje - toto 

číslo je nadále odmocněno a výsledek se rovná počtu pixelů, které odpovídají 

jedné reálné délce strany kalibračního čtverce. 

Po provedení funkce Analyze › Analyze Particles z minulého kroku se 

v ImageJ zjistí počet pixelů všech objektů v dříve binarizovaném obraze. Je 

třeba mít aktivní položku Show Results a poté v okně výsledků identifikovat 

objekt kalibračního čtverce (v tabulce nalezneme odpovídající identifikační 

číslo). Ve sloupci Area bude číslo značící obsah čtverce v pixelech. Toto číslo 

odmocníme a výsledek si poznamenáme. Kalibraci nastavujeme funkcí Analyze 

› Set Scale. Do řádku Distance in pixels vložíme poznamenaný výsledek a do 

řádku Known distance skutečnou délku jedné hrany čtverce. Tuto délku 

uvedeme v jednotkách, které vyplníme do řádku Unit of length. 
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Kalibraci měřítka lze nastavit i ručně pomocí nástroje výběru čarou 

(Straight). Po aktivaci nástroje vybereme takovou část obrazu, u které známe 

její reálné rozměry (například hranu kalibračního čtverce). Při vyvolání 

nabídky Analyze › Set Scale ImageJ automaticky doplní hodnotu v pixelech do 

řádky Distance in pixels. V tomto případě ale narážíme na možnou nepřesnost 

danou lidským faktorem a navíc se rapidně zvýší časová zátěž při 

vyhodnocování výsledků dávkovým zpracováním (viz výsledky v podkapitole 

9.2.6). 

Obrázek 7: Ukázka správně nafoceného snímku pro účely metodiky. Uprostřed snímku 

můţeme vidět kalibrační čtverec, vlevo nahoře kategorizační údaje 
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8.2.7 Práce s makrem 

Součástí metodiky je i jiţ vytvořené makro. Toto makro je úzce 

zaměřené na pouţití s touto metodikou, proto jeho aplikace na jiné úkoly závisí 

na jejich vzájemné podobnosti.  

Makro se z hlediska interakce s uţivatelem skládá ze tří kroků: 

 INSTALACE A SPUŠTĚNÍ MAKRA 

Spuštění makra se děje příkazem Macros › Run. Alternativně je moţné 

makro přidat do nabídky příkazem Macros › Install a poté spustit přímo 

z nabídky Macros, jak je naznačeno v Obrázku 8. Pro trvalé vloţení makra 

jako příkazu do nabídky ImageJ je nutné makro s příponou .ijm zkopírovat do 

sloţky, kde ImageJ uchovává pluginy. 

 KATEGORIZACE 

V tomto kroku vyplňuje uţivatel kategorizační údaje. Prvním údajem je 

město, které slouţí jako označení celého jednoho květníku. Druhým je číslo 

reprezentující kaţdou jednotlivou větev květníku. 

  

Obrázek 8: Spuštění makra 
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 VÝBĚR KALIBRAČNÍHO ČTVERCE 

V tomto kroku je uţivatel vyzván, aby zvolil objekt kalibračního 

čtverce. Po stisknutí OK se provede poslední sada kroků algoritmu a je 

vytvořena stromová struktura, kde první sloţka náleţí jménu města, další 

podsloţka kategorizačnímu číslu a v ní je uloţen obrázek s vyznačenými 

objekty a tabulka výsledků, jak je naznačeno v Obrázku 11. 

Obrázek 9: Kategorizace 

Obrázek 10: Výběr kalibračního čtverce 
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8.2.7.1 Editace makra 

Další výhodou makra je moţnost editace přímo z ImageJ pomocí 

příkazu Macros › Edit. Toto konkrétní makro je pro častou editaci uţ 

připraveno. Obsahuje několik globálních proměnných, kterými se dají měnit 

parametry pravděpodobně nejčastěji pouţívaných funkcí. Dále je kaţdý příkaz 

a kus algoritmu podrobně vysvětlen tak, aby se dal případně jednoduše 

modifikovat pro jiné podobné úlohy. 

Obrázek 11: Stromová struktura s výsledky vytvořenými makrem 
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9 Analýza výsledků 

 Porovnání výsledků z původní a nové metodiky 9.1

Porovnávání obou metodik probíhalo na základě vzorku padesáti 

výstřiţků listů, u kterých byla zjišťována plocha nejdříve původní metodou a 

poté pomocí nové metodiky.  

Na Obrázku 12 lze vidět odchylku plochy naměřené ImageJ vůči ploše 

měřené původní metodou. Odchylka 0 % znamená naprostou shodu mezi 

naměřenými výsledky.  

Odchylka je maximálně 15 % v jednotlivých případech. Je ale třeba říct, 

ţe většinou se jedná o listy o menší ploše (2–20 cm
2
). Průměrná vypočítaná 

odchylka nové metodiky oproti původní metodice je 0,9 %. 

 Dílčí experimenty 9.2

V průběhu vytváření metodiky se zkoumalo několik faktorů, jako vliv 

světla na moţnosti rozpoznávání programu, výběr vhodného pozadí pro 

efektivní rozpoznávání, moţnosti skeneru pro analýzu. 
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Obrázek 12: Graf znázorňující odchylku v % u kaţdého zkoumaného výstřiţku. 
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 VLIV SVĚTLA NA ROZPOZNANOU VELIKOST PLOCHY 

OBJEKTŮ 

Pro potvrzení nebo vyvrácení hypotézy vlivu světla na výpočet plochy 

objektů o stejné reálné ploše byl navrhnut tento experiment. Na Obrázku 13 lze 

vidět rozloţení pěti objektů čtvercového tvaru. Tato scéna byla focena 

v pravidelných intervalech po 10 minutách v denním světle a následně dvakrát 

při přímém umělém osvětlení. Čtverec číslo 3 uprostřed plnil funkci 

kalibračního čtverce. 

1 2 

3 

4 5 

Obrázek 14: Graf znázorňující změnu obsahu objektů v závislosti na měnících 

se světelných podmínkách v průběhu měření  

Obrázek 13: Rozloţení objektů pro graf v obrázku 14 
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Jak je vidět v grafu (Obrázek 14), obsahy povrchu objektů zůstávaly 

v průběhu času konstantní a to včetně posledních dvou naměřených výsledků. 

Z toho lze usuzovat, ţe na vině rozdílně naměřených povrchů objektů nebude 

světlo, ale spíše optická deformace způsobená objektivem fotoaparátu (více 

v podkapitole 8.2.2). 

 VHODNÉ POZADÍ 

Jako vhodné barvy pro potřeby focení listů se jevily modrá, červená, 

bílá nebo černá (více viz podkapitola 8.2.1). Bílá barva nebyla pouţita 

z důvodu shodné barvy kalibračního čtverce. Modré a červené pozadí 

nedokázaly eliminovat stíny, které listy vrhaly (viz Obrázek 15), proto bylo 

nakonec zvoleno pozadí černé, které stíny eliminovalo a zároveň bylo 

dostatečně kontrastní vůči zeleni listů. 

  

Obrázek 15: Na modrém a červeném pozadí byly vidět ostré stíny, coţ ve výsledku 

negativně ovlivnilo analýzu objektu snímku. Vlevo: původní snímek. Vpravo: 

Analyzovaný objekt, včetně stínu. 
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 POUŽITÍ SKENERU 

Před vytvořením samotné metodiky bylo třeba z dostupných zařízení 

vybrat to vhodnější. Skener byl nakonec uznán jako méně vhodný a to 

z důvodu časové náročnosti na snímání obrázku
6
, malého prostoru pro 

pokládání listů a tvorbě neţádoucích stínů jako v Obrázku 15.  

 Souhrnné výsledky 9.3

Tabulky 2 a 3 níţe obsahují souhrnné a vypočítané výsledky získané 

během 3 měření. Pro účely porovnání bylo zrekonstruováno několik měření 

pomocí původní metodiky, jak ukazuje tabulka 4.  

Celkový počet vzorků 4329 listů křídlatky 

Celkový čas focení 12 hodin 30minut
7
 

Celkový počet fotografií 298 

Celkový počet květníků 14 

Průměrná doba přípravy série
8
 listů pro jeden snímek 2 minuty 30 sekund 

Odhadovaná doba přípravy jednoho listu a jeho 

nafocení 

10 sekund 

Průměrná doba analýzy jednoho snímku bez pomoci 

makra 

1 minuta 36 sekund 

Průměrná doba analýzy jednoho snímku s pomocí 

makra 

11 sekund 

Tabulka 2: Souhrnná data získaná reálným měřením 

 

                                                 
6
 Doba skenování jedné A4 při 300dpi trvala přibliţně 1 minutu. 

7
 Zde se udává pouze čas strávený přípravou listů a získáváním fotografií. 

8
 Pro účely porovnání se počítá s 20 listy různých velikostí. 
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Název květníku Počet větví Datum pořízení 

Kojčice 25 12.7.2011 

Krumlov 11 12.7.2011 

Moravce 16 12.7.2011 

Bratislava 11 20.9.2011 

Kácov 23 20.9.2011 

Kolíňany 8 20.9.2011 

Brno 17 20.10.2011 

Kácov 2 20.10.2011 

Kojčice 43 20.10.2011 

Kolíňany 2 20.10.2011 

Krumlov 11 20.10.2011 

Moravce 29 20.10.2011 

Nitra 17 20.10.2011 

Řečice 39 20.10.2011 

Tabulka 3: Počet větví kaţdého květníku 

Tabulka 4: Odhadovaná data vztahující se k časové náročnosti původní metodiky 

 

Z naměřených údajů vyplývá, ţe se práce zrychlilo přibliţně o  84,4 % 

při vyuţití ruční počítačové analýzy a o 90,8 % při pouţití makra. Jde ale 

pouze o odhadované veličiny, protoţe reálné údaje o časové náročnosti 

původní metodiky nebyly k dispozici. 

Průměrná doba vytvoření jedné kopie listu podle 

původní metodiky 

1 minuta 20 sekund 

Průměrná doba zvážení a výpočtu plochy série kopií listů 

podle původní metodiky 

47 sekund 
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10 Závěr 
Hlavním cílem bakalářské práce bylo vytvoření návrhu a realizace 

metodiky pro hromadné měření obsahu plochy listů. Tento cíl se podařilo splnit 

a to včetně všech dílčích částí. Místnost v laboratoři Ústavu systémové biologie 

a ekologie byla přizpůsobena k provádění experimentu. Dále bylo 

naprogramováno makro pro snadné dávkové zpracování. Posledním logickým 

krokem bylo sepsání sady pravidel, která musejí být dodrţena pro správný 

postup metodiky a dosaţení kýţených výsledků. Byly splněny všechny vstupní 

podmínky. Podařilo se dokázat, ţe přesnost metodiky se pohybuje v daných 

mezích a v práci je i naznačená časová úspora nového řešení oproti původnímu 

postupu. Podle mého mínění je celá metodika v praxi velmi dobře pouţitelná. 

V tomto názoru mě utvrzuje mimo jiné fakt, ţe je v tuto chvíli uţ aktivně 

pouţívána na Akademii věd místo původní metodiky. 

Další součástí práce je i seznámení s programem ImageJ. Nejde o 

podrobný popis aplikace, jako je k nalezení například v [8], coţ ani nebylo 

cílem. Program je popsán jen do takových detailů, jaké jsou nutné nebo 

vyuţitelné pro účely metodiky. Proto v průběhu čtení popisu kroků metodiky 

lze nalézt i konkrétní rady a postupy v ImageJ k řešení specifických problémů, 

na které je moţné při aplikaci metodiky narazit. 

Kromě popisu programu ImageJ práce obsahuje i stručný popis dalších 

freeware programů, které by mohly eventuálně ImageJ nahradit. Původní 

předpoklad byl takový, ţe bude tato část mnohem obsáhlejší, ale po čase 

stráveném hledáním konkurenčních aplikací bylo zjištěno, ţe dostatečně 

univerzálních programů pro analýzu obrazu je sice celá řada, ale téměř ţádný 

z nich není zadarmo. Proto se seznam konkurentů zúţil na tři programy. 
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Příloha – DVD 

Na tomto přiloţeném médiu je moţné nalézt sloţku „Makro“, kde 

je uloţené makro ve formátu .ijm. Dále je zde sloţka „Mereni“, která 

obsahuje veškeré fotografie ze tří měření (v podsloţkách podle data 

pořízení). V nich dále najdeme i výstup z program ImageJ takový, jak je 

naznačeno v Obrázku 11. 


